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Purpose
This document is designed to get you started capturing and analyzing data with the ComProbe® Protocol Analysis
System (CPAS). We’ll do this by going through one of the data capture methods available in CPAS.

What this document does not do is cover all methods of data capture or data analysis for CPAS. We wanted to
provide a solid foundation for early success in capturing data and using some of the tools to view and analyze what
you capture.

This document is designed to get you started creating protocol decoders using Frontline's proprietary Decoder-
Script language. DecoderScript can be a bit intimidating at first, but once you understand some basic concepts, it’s
remarkably simple. In the most direct way, this document and the accompanying wizard will walk you through the
mechanics of creating a very simple protocol decoder.

When we say a "simple" decoder we mean it. As a programmer you probably can not count the number of times
that some simple business need turned into a major development effort. The worst is when you are working on a
project and you just know there is a way to do some simple thing and it takes forever to discover how. Many times
all you need is a well directed hint; something to get you started. The hint might be the name of the API needed to
do a thing or a simple example.

One of the best hints is a simple, “hello world” program that provides a needed development shell. That's what we
want to do here, provide that "shell". By itself, the shell is not going to be very useful. As a framework for your own
modifications, however, it could save you a lot of time.

This document is divided into 4 sections:

l Introduction

l Run the Wizard

l Have a look around

l Debug your methods

Introduction
The Frontline ComProbe Protocol Analysis System is a protocol analysis system that may be used with a variety of
different ComProbes (hardware interfaces for capturing different technologies) available from Frontline. The
ComProbe software automatically detects the ComProbe hardware plugged into your PC and configures itself
according to the requirements of your sniffing hardware.

This document assumes that you have already loaded the device drivers and installed the ComProbe software. If
our assumption is correct, you can move to the next section and we will get started. If, however, you have not
installed drivers and software, you need to stop here and follow the Quick Start Guide for the ComProbe hardware
you’re planning to use.

Computer Minimum System Requirements
Frontline supports the following computer systems configurations:
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l Operating System: Windows 7 and 8

l USB Port: USB 2.0 or USB 3.0 High-Speed

The ComProbe software must operate on a computer with the following minimum characteristics.

l Processor: Core i5 processor at 2.7 GHz

l RAM: 4 GB

l Free Hard Disk Space: 20 GB

Getting Started
In this chapter we introduce you to the ComProbe hardware and show how to start the ComProbe analyzer soft-
ware and explain the basic software controls and features for conducting the protocol analysis.

ControlWindow Toolbar

Toolbar icon displays vary according to operating mode and/or data displayed. Available icons appear in color,
while unavailable icon are not visible. Grayed-out icons are available for the ComProbe hardware and software con-
figuration in use but are not active until certain operating conditions occur. All toolbar icons have corresponding
menu bar items or options.

Icon Description

Open File - Opens a capture file.

I/O Settings - Opens settings

Start Capture - Begins data capture to disk

Stop Capture - Available after data capture has started. Click to stop data capture. Data can
be reviewed and saved, but no new data can be captured.

Save - Saves the file the capture file.

Clear - Clears or saves the capture file.

Event Display - (framed data only) Opens a Event Display, with the currently selected bytes
highlighted.

FrameDisplay - (framed data only) Opens a FrameDisplay, with the frame of the currently
selected bytes highlighted.

Notes - Opens the Notes dialog.

Statistics Window - Opens up the Statistics window.

Table 3-1 Control Window Toolbar Icon List
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Icon Description

Cascade - Arranges windows in a cascaded display.

Bluetooth Packet Timeline - Opens the Packet Timeline dialog.

Coexistence View - Opens the Coexistence View dialog.

Low energy - Opens the low energy Timeline dialog.

Bluetooth low energy Packet Error Rate Statistics - Opens the Packet Error Rate Statistics
window.

Bluetooth Classic Packet Error Rate Statistics - Opens the Packet Error Rate Statistics win-
dow.

Wi-Fi Error Statistics - Opens theWi-Fi Error Statistics dialog.

Bluetooth® Protocol Expert System - Opens BluetoothProtocol Expert System window

Audio Expert System - Opens Audio Expert System window

Table 3-1 Control Window Toolbar Icon List (continued)

Opening/Selecting Data Capture Method
At this point, your ComProbe(s) should be plugged in and the drivers configured. The drivers should load auto-
matically when your ComProbe hardware is plugged in.

Run the “Frontline ComProbe Protocol Analysis System” shortcut from the “Frontline ComProbe Protocol Analysis
System [version #] folder, or go to Start -> Programs -> Frontline ComProbe Protocol Analysis System [version #]
and click on Frontline ComProbe Protocol Analysis System shortcut.

The Select Data Capture Method dialog appears (Figure 1).
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Figure 1. Select Data Capture Method Dialog

The selections offered to you will vary according to the hardware you have plugged in. Only those data capture
methods that may be performed with the attached hardware will appear.

For the purposes of this document, we’ll assume that the ComProbeBPA 500 Bluetooth Dual Mode analyzer is
plugged in.

1. Expand the tree for Classic/low energy Air Sniffing (Figure 2).

Notice the options available for each method. If you click on an option, a short description appears on the
right of the dialog.
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Figure 2. Select Data Capture Methods Expanded

As wementioned earlier in the Introduction, in this guide we are going to select one of the most commonly
used options and explain how to analyze the results. If you need to know how to configure your hardware,
or configure data capture settings, please refer to the Quick Start Guide for your ComProbe hardware.

2. Select "Combined Connection (Classic/low energy)".

3. Select "Run".

Analyzing Data
Control Window

First of all, we have the Control window, which appears as the small rectangular window at the top of your screen
(Figure 3).
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Figure 3. Control Window

ComProbe BPA 500 analyzer organized around this window. The Control window allows you to control data cap-
ture and access the other windows used to view data.

While there are a number of dialogs you can use to analyze the data, let's look quickly at some of the options you
have.

Frame Display

Click the Frame Display icon on the Control window toolbar to open Frame Display (Figure 4).

Figure 4. Frame Display
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Protocol Tabs

The Frame Display adds a tab to the top of the Summary Pane for every protocol found in the in the data. You can
click on these tabs to filter on the protocol. Protocols are also arranged by technology groups. When the same pro-
tocol appears in multiple technologies, the data will be displayed in separate groups. For example, if there are Clas-
sic, low energy, and/or 802.11 data, they will be displayed within a Classic, low energy, and 802.11 group. Clicking
on a protocol tab within a group shows all packets for that protocol and technology. The groups are arranged from
top to bottom as General, Classic, low energy, and 802.11. They are also color-coded: General/Gray, Classic/Light
Blue, low energy/Light Green, and Wi-Fi/Orange.

If a protocol appears in multiple technologies, then a tab for that protocol will appear in the specific technology
group and in the General group.

Select the Unfiltered tab to display all protocols. The Unfiltered tab is automatically selected when multiple pro-
tocols are being filtered-in using other filtering methods.

There are several special tabs that appear in the Summary Pane when certain conditions are met. These include:

l Bookmarks appear when a bookmark is first seen.

l Errors appear when an error is first seen. Errors include decode errors (failure of Verify methods), DRF
error bits, and PDA complaints about decoders. The Errors tab is displayed in red.

l Info appears when a frame containing an Information field is first seen.

l A shown technology has the icon to the left of the first row. A hidden technology has the icon to the right of
the first row of the general tab group.

The new tabs disappear when the capture buffer is cleared during live capture or when decoders are reloaded,
even if one of the new tabs is currently selected. They subsequently reappear as the corresponding events are
detected.

Panes

Frame display allows you to see an amazing amount of information from your protocol. The Frame Display is
divided into panes, where each pane shows a different view of the data.

l The Summary pane (Figure 5) stretches across the top of the display. Each line in the Summary Pane rep-
resents one frame, except when running in one of the USB HCI Sniffing modes where each line represents
one transaction.
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Figure 5. Summary Pane

l The Decode pane (Figure 6) contains a detailed decode of the frame/transaction selected in the Summary
pane, and is located on the left side of the Frame Display window.

Figure 6. Decode Pane

l The three smaller panes on the bottom right of the Frame Display show the data in hex, binary and ASCII (Fig-
ure 7). The user can choose to have these panes show the data in other radixes or character sets. Select any
field in the Decode pane and the corresponding bit(s) or byte(s) will be selected in the data panes.
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Figure 7. Data Format: Binary, Hexidecimal, ASCII

Frame Errors

Frame numbers in red indicate an error in the frame. Select the frame, and look at the top of the Decode pane to
determine the type of error.

Scrolling versus Static View

Click the Lock/Resume icon to have the Summary pane scroll to always show the latest frames captured.

Click the Lock/Resume icon again to stop the Summary pane from scrolling.

Protocol Tabs

The frame display has a series of Protocol Tabs that allow you to filter on a specific protocol quickly and easily. For
more advanced filtering option please consult the online help.

Data Extraction

You use Data/Audio Extraction to pull out data from various decoded Bluetooth® protocols. Once the data are
extracted, you can save them into different file types, such as text files, graphic files, email files, .mp3 files, and
more.

1. You access this dialog by selecting Extract Data/Audio from the View menu or by clicking on the icon

from the toolbar .

2. 2. Choose a checkbox or checkboxes on the left side of the dialog to identify those profile(s) from which
you want to extract data (Figure 8).
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Figure 8. Data/Audio Extraction Dialog

It is important to note that if there is no data for the profile(s) you select, no extracted file is created.

3. If you want the file(s) to open automatically after they are extracted, select the Open File(s) After Extraction
checkbox.

Note: This does not work for SCO/eSCO.

4. Click on a radio button to write the streams as TwoMono Files or as One Stereo File. This option applies for
SCO/eSCO only.

5. Select the checkbox if you want to convert A-Law and µ-law to Linear PCM.

CVSD are always converted to Linear PCM. It's probably a good idea to convert to Linear PCM since more
media players accept this format.

6. Select the Add Silence packets to insert the silence packets (dummy packets) for the reserved empty slots
into the extracted file. If this option is not selected, the audio packets are extracted without inserting the
silence packets for the reserved empty slots. This option is active for SCO/eSCO only.

7. Select Extract.

A Save As dialog appears (Figure 9).
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Figure 9. Save As Dialog

The application will assign a file name and file type for each profile you select in Step 1 above. The file type
varies depending on the original profile. A separate file for each profile will be created, but only for those
profiles with available data.

8. Select a location for the file(s).

9. Click Save.

The Data Extraction Status and Audio Extraction Status dialogs appear (Figure 10). When the process is com-
plete the dialogs display what files have been created and where they are located.
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Figure 10. Data/Audio Extraction Status Dialog

If you selected Open Files(s) After Extraction, the files open automatically. If you did not select this option,
you can open a file by simply double-clicking on the name.

10. When you are finished, select Close to close the dialogs.

Message Sequence Chart

Note: Message Sequence Chart does not apply to these ComProbe Devices: SD

The Message Sequence Chart (MSC) displays a concise overview of a Bluetooth connection, highlighting the essen-
tial elements of the connection. At a glance, you can see the flow of the data, including role switches, connection
requests, and errors. You can look at all the packets in the capture, or filter by protocol/profile. The MSC is color
coded for a clear and easy to use view of your data (Figure 11).
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Figure 11. Message Sequence Chart

How Do I Access The Chart?

You access the Message Sequence Chart by selecting the icon or MSC Chart from the View menu from the Con-

trol Window or Frame Display.

What Do I See?

Along the top of the dialog are a series of tabs, which will vary depending on the protocols.

Figure 12. Protocol Tabs

Clicking on a tab displays the messaging between the master and slave for that protocol (Figure 13). For example, if
you select RFCOMM, you will see the messaging between the RECOMM{M} Master, and the RFCOMM{S} Slave.
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Figure 13. Protocol Messaging

Note: The Non-Message Summary tab displays all the non-message items in the data and the Ctrl Summary tab dis-
plays the signaling packets for all layers in one window in the order in which they are received. The information in
the colored boxes displays general information about the messaging.

When you position the mouse over the message description, you will see an expanded tool tip (Figure 14).
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Figure 14. Protocol Message Expanded Tooltip

How Do I Navigate in the Dialog?

You can use the navigation arrows at the bottom and the right side of the dialog to move vertically and horizontally.
You can also click and hold within the dialog, which brings up a directional arrow that you can use to move left/right
and up/down.

Search

The Message Sequence Chart has a Search function that makes it easy to find a specific type message within the lay-
ers.

You access this dialog by selecting the Search icon or F3, the Search dialog appears (Figure 15).
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Figure 15. Message Sequence Chart Search Dialog

From this dialog you can search for specific protocol messages or search for the first error frame. To use the dialog:

1. Select one of the protocol tabs at the top of the dialog.

2. Open the Search dialog using one of the three methods.

Note: If you select All Layers in Step 1, the Protocol Layers drop-down list is active. If you select any of the
other single protocols, the Protocol Layers drop-down is grayed out.

3. Select a specific Protocol Message from the drop-down list (Figure 16).
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Figure 16. Protocol Drop-Down List

4. 4. Once you select the Protocol Message, click OK.

The Search dialog disappears and the first search result is highlight in the Message Sequence Chart (Figure
17).
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Figure 17. Message Sequence Chart Search Result - Highlighted

If there is no instance of the search value, you see the following dialog (Figure 18).

Figure 18. Search No Instance Found Dialog

Once you have set the search value, you can 1) use the Search Previous and Search Next buttons or 2)
F2 and F3 to move to the next or previous frame in the chart.

PER Stats

Note: PER Stats does not apply to these ComProbe Devices: SD

The Packet Error Rate Stats (PER Stats) Plug-in provides a dynamic graphical representation of the Packet Error Rate
for each channel (Figure 19).
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Figure 19. PER Stats Dialog

Packet Error Rate Stats assist in detecting bad communication connections. When a high percentage of re-trans-
mits, and/or header/payload errors occur, careful analysis of the statistics indicate whether the two devices under
test are experiencing trouble communicating, or the packet sniffer is having difficulty listening.

Generally, if the statistics display either a large number of re-transmits with few errors or an equal number of
errors and re-transmits, then the two devices are not communicating clearly. However, if the statistics display a
large number of errors and a small number of re-transmits, then the packet sniffer is not receiving the trans-
missions clearly.

l Each channel contains a bar that displays the number of packets with no errors in green, packets with
Header Errors in red, packets with Payload or CRC errors in dark red, and Retransmitted packets in yellow.

l When you select a channel, detailed information for that channel is displayed in the expanded channel
chart on the upper right.

o The number of packets with no errors is displayed in light green in the bar chart.

o The number of packets that have header errors is displayed in red in the bar chart.

o The number of payload errors is displayed in dark red in the bar chart.
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o The number of re-transmits is displayed in yellow in the bar chart.

o When you select the in the upper-right corner, the bar chart is replaced by a pie chart (Figure
20). To return to the bar chart, click on the channel again.

Figure 20. PER Stats All-Channel Pie Chart

l In the Scroll bar captured data begins to appear on the left and fills the width of the bar, left to right.

l The vertical bars in the Scroll Bar each indicate a fixed duration. When data first appears in the Scroll Bar as
it is being captured, each bar equals one second. When the data fills the bar, reaching the right side limit,
the last bar moves back to the center of the Scroll Bar. The bars stay the same size, but doubles in duration
(for example, the first time the Scroll Bar fills, the bars return to the middle, but now each bar represent
two seconds of time instead of one). Each time the bars cycle to the middle, the time they represent
doubles.

l The Viewport is used to select single or multiple vertical bars . Clicking on a vertical bar
left justifies the Viewport to that bar. You can drag the sides of the VIewport or the slider buttons to select
multiple bars, representing a greater time range.

l You can click and drag the Viewport within the Scroll Bar.

Bluetooth Timeline

Note:Bluetooth Timeline does not apply to these ComProbe Devices: 802.11, SD

The Bluetooth Timeline displays packet information in a main timeline that can display data over different periods
of time and also in graph and chart form. Instead of just raw numbers and characters, the Timeline displays when
packets occur, their speed, type, their payload, errors, retransmits, and more (Figure 21).
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You access the Bluetooth Timeline by selecting the icon from the Control Window or Frame Display toolbars
or Bluetooth Timeline from the View menus.

Figure 21. Bluetooth Timeline Dialog
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Bluetooth Timeline Display

The timeline (Figure 22) displays multiple rows of time, from left to right, top to bottom, just like a book. Inform-
ation for the Master and Slave are shown on separate lines. Each packet type is a different color. The packet and
corresponding color are shown on the legend.

Figure 22. Bluetooth Timeline Display

Bluetooth Legend

This legend identifies the color coding found in the timeline (Figure 23).

Figure 23. Bluetooth Timeline Legend

Bluetooth Indicators

There are three throughput indicators (Figure 24).
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Figure 24. Bluetooth Timeline Indicators

l Average throughput is the total payload over the entire session divided by the total time.

l 1-Second Payload Throughput is the total payload over the most recent one second of duration.

l Average Throughput for a selected packet range displays the data for a single packet when you select that
packet from the Timeline.

Bluetooth Throughput Graph

Payload Throughput over Time shows throughput over a period of time in a graph (Figure 25).

Figure 25. Bluetooth Timeline Payload Throughput Over Time

Bluetooth low energy Timeline

Note:Bluetooth low energy Timeline does not apply to these ComProbe Devices: 802.11, SD

There is also a Bluetooth low energy Timeline that is very similar to the Classic Bluetooth Timeline.

Coexistence View

The Coexistence View displays Bluetooth and the 802.11 channels frequencies in one view or separately (Figure
26).
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You access the Coexistence View by selecting the icon from the Control Window or Frame Display toolbars or
Coexistence View from the View menus.

Figure 26. Coexistence View Dialog

Coexistence View Timeline

In the Timeline you can see what packets were being transmitted, when they were transmitted, and how they
relate to each other (Figure 27).
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Figure 27. Coexistence View Timeline Display - Wi-Fi and Bluetooth

You can see Classic Bluetooth and Wi-Fi together in the 2.4 gigahertz range, the Bluetooth channels being blue and
the Wi-Fi being orange, or you can view only Wi-Fi in the 5 gigahertz range. The packets are color coded, which you
can match up to the Legend to see the packet type.

Coexistence View Legend

Any packet type that is seen in the current session is shown in bold in the Legend. When you select a packet type,
the attributes for the packet are highlighted in the legend. Blue is for Bluetooth and orange is for 802.11 (Figure
28).

Figure 28. Coexistence View Legend

Coexistence View Indicators

The throughput indicators show average throughput and one-second throughput for both Bluetooth and Wi-Fi. For
Bluetooth these indicators segregate the master and slave values (Figure 29).
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Figure 29. Coexistence View Throughput Indicators

Coexistence View Throughput Graph

The throughput graph displays throughput over time (Figure 30).

Figure 30. Coexistence View Throughput Graph

You can see a line that displays the packet throughput for Bluetooth and Wi-Fi.You can also see a line that displays
the payload throughput for both Bluetooth and Wi-Fi.

The data lines and y-axis labels are color-coded:  Blue = Classic Bluetooth, Green = Bluetooth low energy, Orange =
802.11.
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Display Synchronization

The system synchronizes the display in the Frame Display with the Event Display. Select a frame in the Frame Dis-
play and the other windows automatically update to highlight the bytes in the selected frame. Select a byte in the
Message Sequencing Chart and the Frame Display and Event Display updates to show the frame containing the
byte.

Duplicate Displays

The Duplicate icon creates a second window of the same type, identical to the first. The advantage of additional
Displays is that you can look at two different groups of data at the same time. For example, you can look at the start
of an interaction in one Frame Display and the end of that same interaction in the other and compare the two.

Bookmarks

Bookmarks let you mark frames of interest so they can be easily found later. Bookmarked frames appear with a
magenta triangle icon next to them except in the Event Display where they appear as a dashed line around the start
of frame marker. You can navigate between bookmarks using the Find feature or by pressing F2 to go to the next
bookmark. To make a new bookmark, right-click on the frame and choose Add Bookmark from the Searching
menu.

You can search for strings or patterns in your data or in the frame decode, for errors, control signal changes, book-
marks, special events, and time. Click the Find icon to open the Find window. Click the Help button for more

information on the different types of searches.

Navigating and Search the Data
Find

Capturing and decoding data within the ComProbe® analyzer produces a wealth of information for analysis. This
mass of information by itself, however, is just that, a mass of information. There has to be ways to manage the
information. ComProbe software provides a number of different methods for making the data more accessible.
One of these methods is Find.
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Figure 3-1. Find Dialog

Find, as the name suggests, is a comprehensive search function that allows users to search for strings or patterns in
the data or in the frame decode. You can search for errors, control signal changes, bookmarks, special events,
time, and more. Once the information is located, you can easily move to every instance of the Find results.

Filter
3.30.0.1 About Display Filters

A display filter looks at frames that have already been captured. It looks at every frame in the capture buffer and
displays those that match the filter criteria. Frames that do not match the filter criteria are not displayed. Display fil-
ters allow a user to look at a subset of captured data without affecting the capture content. There are three general
classes of display filters:

l Protocol Filters

l Named Filters

l Quick Filter

Protocol Filters

Protocol filters test for the existence of a specific single layer. The system creates a protocol filter for each decoder
that is loaded if that layer is encountered in a capture session.

There are also three special purpose filters that are treated as protocol filters:

l All Frames with Errors

l All Frames with Bookmarks

l All Special Information Nodes



29

Named Filters

l Named filters test for anything other than simple single layer existence. Named filters can be constructed
that test for the existence of multiple layers, field values in layers, frame sizes, etc., as well as combinations
of those things. Named filters are persistent across sessions.

l Named filters are user-defined. User-defined filters persist in a template file. User defined filters can be
deleted.

Quick Filters

l Quick Filters are combinations of Protocol Filters and/or Named Filters that are displayed on the Quick Filter
tab.

l Quick Filters cannot be saved and do not persist across sessions.

l Quick Filters are created on the Quick Filter Dialog.

3.30.0.2 Quick Filtering on a Protocol Layer

On the FrameDisplay , click the Quick Filtering icon or selectQuick Filtering from the Filtermenu.

This opens a dialog that lists all the protocols discovered so far. The protocols displayed change depending on the
data received.

Figure 3-2. FrameDisplay Quick Filtering and Hiding Protocols Dialog
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The box on the left is Protocols To Filter In. When you select the checkbox for a protocol in the Protocols to Filter
In, the Summary pane will only display those frames that contain data from that protocol.

If you filter on more than one protocol, the result are all frames that contain at least one of
those protocols. For example, if you filter on IP and IPX NetBIOS, you receive all frames that
contain either IP or IPX NetBIOS (or both). A Quick Filter tab then appears on the FrameDisplay. Changing the fil-
ter definition on the Quick Filter dialog changes the filter applied on the Quick Filter tab. Quick filters are per-
sistent during the session, but are discarded when the session is closed.

The box in the center is the Protocols To Hide. When you select the checkbox for a protocol in the Protocols To
Hide, data for that protocol will not appear in the Decode, Binary,Radix, and Character panes. The frames con-
taining that type data will still appear in the Summary pane, but not in the Decode, Binary,Radix, and Character
panes.

The box on the right is the Named Filters. It contains filters that you create
using the Named Filter and Set Condition dialogs. When you select the check-
box for the Name Filters, a tab appears on the Summary Pane that displays
the frame containing the specific data identified in the filter. The named Fil-

ter tab remains on the Frame Display Summary Pane unless
you hide it using the Hide/Show Display Filters dialog.

With low energy, the Configured BT Low energy devices and
Exclude NULLS and POLLs are default named filters.

Check the small box next to the name of each protocol you want to filter in,
hide, or Named Filter to display.

Then clickOK

Printing and Exporting
Printing from the Frame Display/HTML Export

The FrameDisplay Print dialog and the FrameDisplay HTMLExport are very similar. This topic discusses both
dialogs.

Frame Display Print

The FrameDisplay Print feature provides the user with the option to print the capture buffer or the current selec-
tion. The maximum file size, however, that can be exported is 1000 frames.

When Print Preview is selected, the output displays in a browser print preview window, where the user can select
from the standard print options. The output file format is in html, and uses the Microsoft Web Browser Control
print options for background colors and images.

Print Background Colors Using Internet Explorer

1. Open the Tools menu on the browser menu bar

2. Select “Internet Options…” menu entry.

3. Click Advanced tab.

4. Check “Print background colors and images” under the Printing section

5. Click the Apply button, then click OK



31

Configure the Print File Range in the Frame Display Print Dialog

Selecting more than one frame in the Frame Display window defaults the radio button in the Frame Display Print
dialog to Selection and allows the user to choose the All radio button. When only one frame is selected, the All
radio button in the Frame Display Print dialog is selected.

How to Print Frame Display Data

1. SelectPrint or Print Preview from the Filemenu on the FrameDisplay window to display the FrameDis-
play Print dialog. SelectPrint if you just want to print your data to your default printer. SelectPrint Preview
if you want access to printer options.

2. Choose to include the Summary pane (check the box) in the print output. The Summary pane appears at
the beginning of the printed output in tabular format. If you selectAll layers in the Detail Section, the
Data Bytes option becomes available.

3. In the Detail Section, choose to exclude—No decode section—the decode from the Detail pane in the
FrameDisplay, or include All Layers or Selected Layers Only. If you choose to include selected layers,
then select (click on and highlight) the layers from the list box.

4. Click on selected layers in the list to de-select, or click the Reset Selected Layers button to de-select all
selected layers.

Figure 3-3. FrameDisplay Print Dialog

5. Select the range of frames to include All or Selection in the FrameRange section of the FrameDisplay
Print dialog.

Choosing All prints up to 1000 frames from the buffer.

Choosing Selection prints only the frames you select in the Frame Display window.

6. Selecting the Delete File deletes the temporary html file that was used during printing

7. Click the OK button.
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Frame Display Print Preview

The FrameDisplay Print Preview feature provides the user with the option to export the capture buffer to an
.html file. The maximum file size, however, that can be exported is 1000 frames.

If you chose Print Preview, the system displays your data in a browser print preview display with options for print-
ing such as page orientation and paper size. You can also use your Printer Preferences dialog to make some of
these selections. When printing your data, the analyzer creates an html file and prints the path to the file at the bot-
tom of the page. This file can be opened in your browser, however, it may appear different than the printed ver-
sion.

1. SelectPrint Preview from the Filemenu on the FrameDisplay window to display the FrameDisplay
Print Preview.

Figure 3-4. FrameDisplay Print Preview Dialog

2. From this point the procedure is the same as steps 2 through 5 in "How to Print Frame Display Data" above.

3. Click the OK button, and after a brief wait a browser window will appear.

Printing from the Event Display

The Event Display Print feature provides the user with the option to print either the entire capture buffer or the
current selection. When Print Preview is selected, the output displays in a browser print preview window where
the user can select from the standard print options. The output file format is in html, and uses the Microsoft Web
Browser Control print options for background colors and images (see below).

Print Background Colors Using Internet Explorer

1. Open the Tools menu on the browser menu bar

2. Select “Internet Options…” menu entry.

3. Click Advanced tab.
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4. Check “Print background colors and images” under the Printing section

5. Click the Apply button, then click OK

The Event Display Print feature uses the current format of the Event Display as specified by the user.

See About Event Display for an explanation on formatting the Event Display prior to initiating the print feature.

Configure the Print File Range in the Event Display Print dialog

Selecting more than one event in the Event Display window defaults the radio button in the Event Display Print
dialog to Selection and allows the user to choose the All radio button. When only one event is selected , the All
radio button in the Event Display Print dialog is selected.

How to Print Event Display Data to a Browser

1. SelectPrint or Print Preview from the Filemenu on the Event Display window to display the Event Dis-
play Print dialog. SelectPrint if you just want to print your data to your default printer. SelectPrint Preview
if you want preview the print in your browser.

2. Select the range of events to include from either All or Selection in the Event Range section . Choosing All
prints all of the events in the capture file or buffer. Choosing Selection prints only the selected events in
the Event Display window.

Note: In order to prevent a Print crash, you cannot select All if there aremore than
100,000 events in the capture buffer.

Note: See "Configure the Print File Range in the Event Display Print Dialog" above for an
explanation of these selections

Figure 3-5. Event Display Print Dialog

3. Click the OK button.

If you chose Print Preview, the system displays your data in a browser print preview display with options for print-
ing such as page orientation and paper size. You can also use your Printer Preferences dialog to make some of
these selections. When printing your data, the analyzer creates an html file and prints the path to the file at the bot-
tom of the page. This file can be opened in your browser, however, it may appear different than the printed ver-
sion.
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Frame Display Export

You can dump the contents of the Summary pane on the FrameDisplay into a Comma Separated File (.csv).

To access this feature:

1. Right click on the Summary pane or open the FrameDisplay Filemenu.

2. Select the Export…menu item.

3. Select a storage location and enter a File name.

4. SelectSave.

Export Filter Out

You can filter out data you don't want or need in your text file.

(This option is available only for serial data.) In the Filter Out box, choose which side to filter out: the DTE data, the
DCE data or neither side (don't filter any data.) For example, if you choose the radio button for DTE data, the DTE
data would be filtered out of your export file and the file would contain only the DCE data.

You can also filter out Special Events (which is everything that is not a data byte, such as control signal changes and
Set I/O events), Non-printable characters or both. If you choose to filter out Special Events, your export file would
contain only the data bytes. Filtering out the non-printable characters means that your export file would contain
only special events and data bytes classified as printable. In ASCII, printable characters are those with hex values
between $20 and $7e.

3.31 Technical Support
Technical support is available in several ways. The online help system provides answers to many user related ques-
tions. Frontline’s website has documentation on common problems, as well as software upgrades and utilities to
use with our products.

Web: http://www.fte.com, click Support

Email: tech_support@fte.com

If you need to talk to a technical support representative, support is available between 9am and 5pm, U.S. Eastern
time, Monday through Friday. Technical support is not available on U.S. national holidays.

Phone: +1 (434) 984-4500

Fax: +1 (434) 984-4505

http://www.fte.com/
mailto:tech_support@fte.com?subject=ComProbe Techncial Help

	Purpose
	Introduction
	Computer Minimum System Requirements
	Getting Started
	Control Window Toolbar

	Opening/Selecting Data Capture Method
	Analyzing Data
	Control Window
	Frame Display
	Protocol Tabs

	Data Extraction
	Message Sequence Chart
	How Do I Access The Chart?
	What Do I See?
	How Do I Navigate in the Dialog?
	Search

	PER Stats
	Bluetooth Timeline
	Bluetooth Timeline Display
	Bluetooth Legend
	Bluetooth Indicators
	Bluetooth Throughput Graph

	Bluetooth low energy Timeline
	Coexistence View
	Coexistence View Timeline
	Coexistence View Legend
	Coexistence View Indicators
	Coexistence View Throughput Graph

	Display Synchronization
	Duplicate Displays
	Bookmarks

	Navigating and Search the Data
	Find
	Filter
	3.30.0.1  About Display Filters
	3.30.0.2  Quick Filtering on a Protocol Layer


	Printing and Exporting
	Printing from the Frame Display/HTML Export
	Printing from the Event Display
	Frame Display Export
	Export Filter Out

	3.31  Technical Support
	Bookmarks
	SelectDataCaptureMethod
	SelectDataCaptureMethodExpanded
	ControlWindow
	FrameDisplay
	SummaryPane
	DecodePane
	DataFormat
	DataAudioExtraction
	SaveAs
	ExtractionStatusDialog
	MessageSequenceChart
	ProtocolMessaging
	ExpandedTooltip
	SearchDialog
	ProtocolList
	SearchResults
	SearchNoInstance
	PERStatsDialog
	PieChart
	TimelineDialog
	TimelineDisplay
	TimelineLegend
	Indicators
	PayloadGraph
	CoexistenceViewDiablog
	CoexistenceViewTimeline
	CoexistenceViewLegend
	CoexistenceViewIndicators
	CoexistenceViewThroughputGraph
	Figure 3-1.  Find Dialog
	Figure 3-2.  Frame Display Quick Filtering and Hiding Protocols Dialog
	Figure 3-3.  Frame Display Print Dialog
	Figure 3-4.  Frame Display Print Preview Dialog
	Figure 3-5.  Event Display Print Dialog


